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Purpose 

This procedure facilitates the University of California San Diego’s (UCSD’s) Electronic Plan Review (EPR) 

process using Bluebeam Studio Projects and Sessions. This document will introduce the Design Team to 

the steps required to submit, view, coordinate and respond to UCSD’s EPR comments in Bluebeam Studio 

Sessions from the start of the project through approval from UCSD. It will be determined by UCSD’s project 

management team at the project kick off if the Design Team or UCSD will be the Bluebeam Studio 

manager.  This procedure outlines the steps if it is determined the Design Team will be the Bluebeam 

Studio Manager. 

Please note that Bluebeam software will be needed in order to create the documents for UCSD plan review. 

Following this procedure requires use of Bluebeam Revu eXtreme 2020, 2019, or 2018. Screenshots and 

instructions in this procedure use Bluebeam 2018/2019. 
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Section A – Registration Process 

Using this Procedure 

This workflow is for Design Team comfortable using Bluebeam & Bluebeam Studio software. Workflow 

steps explained in this procedure include creating a Bluebeam Studio Account, prepping PDF files for 

submittal and resubmittal using Bluebeam, creating Bluebeam Studio Projects and Sessions (as 

applicable), submitting files into Bluebeam Projects and Sessions, and the Design Team response to 

University of California San Diego (UCSD) review comments inside a Bluebeam Studio Session. 

Prior to each submittal to UCSD, the Design Team must first format all PDF plans and documents 

following the steps outlined in this procedure. PDF formatting greatly benefits the UCSD review 

process.  

As determined in the Project kickoff meeting, UCSD will also require the Design Team to create the 

Bluebeam Studio Project for submittal and/or the Bluebeam Studio Session for review. This will be 

determined by the UCSD Project team at the start of the project, and when filling out the UCSD 

Electronic Plan Review Cover Sheet.  

As determined in the Project kickoff meeting, UCSD may require the Design Team to insert the UCSD 

Electronic Plan Review Cover sheet into their own submission documents. The UCSD Electronic Plan 

Review Cover sheet defines the responsible party for each of the Bluebeam-related project tasks, and 

the UCSD Departments reviewing the project. It is inserted as the first page in all submission 

documents requiring UCSD review. 

Once the Bluebeam Studio Project is created, the Design Team will then submit formatted plans and 

documents electronically into a Bluebeam Studio Project. The Bluebeam Studio Project serves as 

UCSD’s online storage location for all digital files for each Project receiving a permit. Once the Design 

Team uploads to the Bluebeam Studio Project, the Bluebeam Studio Administrator from UCSD will 

then perform a QAQC verification of the documents.  

Once the Design Team’s submittal files have been accepted, a Bluebeam Studio Session will be 

created for UCSD review. The Bluebeam Studio Review Session is an online location for digital plan 

review. Once UCSD electronic review is complete, the Design Team will join the Bluebeam Studio 

Session to review and incorporate UCSD review comments. 

Account Setup for Bluebeam Studio 

Note: For the Design Team to use EPR in Bluebeam, the Design Team must use Bluebeam Studio 

and create a Bluebeam Studio account. Bluebeam Studio is a cloud-enabled system that is built into 

Bluebeam, that allows UCSD to store files and perform simultaneous plan review of PDFs 

collaborating with the Design Team. Although the Bluebeam Studio Account will not be needed until 

review reconciliation, it should be the very first item completed within this procedure.  

Participation in Bluebeam Studio and account setup does not require a paid version of Bluebeam. 

New Bluebeam Account: Set General Account Name & Create a New Bluebeam Studio Account 

Set Bluebeam General user name for Markups on Bluebeam Revu only and not in a 

Bluebeam Studio Session.  Bluebeam Preferences dialog: The “User” field located in the 

“General” then “Options” tab. 
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Create a New Bluebeam Studio Account 

Locate and click the “Bluebeam Studio” button 

Within the Bluebeam Studio tab click the “Sign In” button  to sign in 

or to create a new Bluebeam Studio account 

Note: When creating an account for the first time, be sure to enter the Display 

Name in the following manner:First Last – Company  (ex: Mary Smith – XYZ 

Architects).  

Existing Bluebeam Account: Set General & Studio Account Display Name 

Note: Design Team name information shall abide by the following protocol: 

First Last – Company  (ex: Mary Smith – XYZ Architects).  

Once the Design Team has signed into Bluebeam, the user Display Name must be correctly 

entered in the following locations within the Preferences Dialog (found in the Revu pull-down 

menu, or press Ctrl + K) 

Set Bluebeam General user name for Bluebeam Revu only and not in a Bluebeam 

Studio Session.  Bluebeam Preferences dialog: The “User” field, located in the “General” 

then “Options” tab 

Set Bluebeam Studio user name for all activities in a Bluebeam Studio Project or 

Session.  Bluebeam Preferences dialog: The “Display Name” field, located in the 

“Bluebeam Studio” tab in the “Server” section 

Alternatively set Bluebeam Studio user name in a web browser, enter 

“studio.bluebeam.com” and log in with the Bluebeam Studio login username and 

password. 
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Select the “My Profile” tab on the left 

Verify the name located in the “Default Name” box 

Correct the name and click the “Update Profile” button 

Log out and then back into Bluebeam Studio once all changes have been made 
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Section B – Initial Document Submission Process 

Prepare Drawing Documents for Initial Submittal 

Note: All documents, including drawing documents, that require UCSD review and/or review 

comments must be PDF file type. Follow the steps outlined in this procedure to prepare applicable 

PDF files prior to submittal to UCSD. 

Many of the steps for preparing a PDF documents require a paid version of Bluebeam. 

Best Practices for PDF Creation 

Note: Design Team is to ensure all best practices for PDF creation are used as applicable. 

Design Teams are recommended to review UCSD’s “EXHIBIT C SUPPLEMENTAL 

REQUIREMENTS EXECUTIVE DESIGN PROFESSIONAL AGREEMENT” for 

additional requirements, including vector-based line, TrueType font, and print-to-page 

requirements. 

A note on Cross-Hatch fills: 

Avoid the use of dense crossed-line fills within drawings whenever possible, as use of 

dense (i.e. less than 1/8” apart on the plotted page) cross-line hatching can lead to 

rendering issues on PDFs. Dot patterns, earth patterns, and brick patterns are okay, as 

lines within those hatch patterns do not typically cross. Solid fill patterns are also 

generally okay if the solid pattern is not made from crossed lines. Use parallel lines 

instead. 

A note on Digital Signatures: 

Do not add certificate-type digital signatures on submittal documents. Files submitted to 

UCSD must be unlocked/unrestricted to editing, and applying a digital signature restricts 

changes to the file. Use only scanned graphic-type signatures if required. 

Verify Document Naming Conventions for Document Submittal 

Ensure all documents are named per Exhibit D: Document Naming Table for 

Submissions 

Include Drawing Index and Total Sheet Count 

Note: Ensure set is coordinated and complete prior to creating PDF of document. 

In drafting software, list total sheet count on drawing sheet index page 



Electronic Plan Review Procedure: Design Team 7/22/2021 
Page 5 

Verify sheet count on the sheet index matches total PDF document sheet count. 

Include Blank Area in Title block for Fire Marshal and other Approval Stamps 

Note: Each drawing page must have a space reserved for UCSD approval stamps. Areas 

defined must be completely blank.  

A 3.3” wide x 2.5” high blank area shall be provided within the title block of the project 

drawings to accommodate the Schematic Review Stamp and/or the Fire Marshal’s 

electronic approval stamp. Top of box is 3.5” down from the top right physical corner of 

the sheet. This reserved blank area must be in the same location for every page in the 

plan set. 
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Verify Document Size 

Do not exceed 1 GB size for any single PDF document. If file size exceeds 1 GB, the 

document shall be broken up into volumes by discipline or consistent number of sheets. 

Refer to Exhibit D: Document Naming Table for Submissions for Volume Naming 

Verify Document Scale 

PDF Drawings shall be plotted/printed at 100% Scale from authoring software. Do not 

“Scale to Fit” or “Fit to Page”. Do not reduce the PDF page size to be smaller than the 

original printed page size. 

Prepare Legacy Scanned Documents (as Applicable) 

Note: Scanned documents are slow to regenerate in Bluebeam – typically defined as taking 

more than 5 seconds per-page to regenerate. All scanned documents or pages that are slow to 

regenerate are required to go through this scanned document preparation section. It is not 

recommended that documents are scanned dots (raster) – ideally, they should be “printed” lines 

(vector). See below. 

Printed document Scanned Document 

Open the scanned PDF file 

From the File Menu (located at the top of the Bluebeam screen), select “Export” 

Click “JPEG” 

Browser window will open 
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Browse to save to a local folder (ideally a new folder). Note the folder location 

Select “Save” 

Note:  The next steps convert JPG Image files created above back to usable PDFs 

From the File menu, select “Create” 

Click “From Multiple Files” 

Browser window will open 
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Locate folder containing JPEGs saved from previous section 

Select image files  

Select Open 

Stapler dialog will open 

Select “Advanced…” Button 

Select 96 dpi from the resolution image drop down 

Select OK 
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Add a file name to the “One Output File”’ field 

Select “Use source file folder” 

 Click OK 

Run Optical Character Recognition (OCR) on any Scanned PDF files 

Note: this OCR Section requires the Bluebeam eXtreme software version. 

From the “Batch” pull-down menu, select “OCR”  
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Confirm All Pages are selected 

Set Document Type to CAD Drawings 

Check “Detect Vertical Text” 

Check “Detect text in pictures and drawings” 

Uncheck all other options 

Click OK 

Create Page Labels 

From any page, zoom into the area containing the sheet’s page number and label 

Go to Thumbnails icon 

Click the Create Page Labels icon to the right of the Thumbnails drop-down 



Electronic Plan Review Procedure: Design Team 7/22/2021 
Page 11 

Select Page Range > Select All Pages 

Select Page Region > Click Select 

Select Region of Page Label > Sheet Number 

Note: Draw a window around the Sheet Number as big as possible while staying inside 

the Title block lines. Avoid selecting additional text besides the Sheet Number. Notice 

the window being sketched within the area highlighted with the red box. 

Enter a space, a hyphen, and a space after [Region 1] 

Click add to select a second region for the bookmark 
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Select Region of Page Label > Sheet Name 

Note: Draw a window around the Sheet Title as big as possible while staying inside the 

Title block lines. Avoid selecting additional text besides the Sheet Name. Notice the 

window being sketched within the area highlighted with the red box. 

Review AutoMark Preview and Click OK. Page Labels will generate 

Review in the Thumbnails tab to verify the sheet number and sheet name have been 

captured properly 

If incorrect, double left-click and change incorrect title(s), or redo Page Labels 
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Create Bookmarks 

Note: Bookmarks are important for document navigation, and can be created directly from Page 

Labels. Verify all Page Labels are complete and correct before creating Bookmarks 

Go to Bookmarks Tab 

Click the “Create Bookmarks” icon 

Select Page Labels and verify Page Range > Click OK 

Page Label content will appear in the Bookmarks tab  

Click the Bookmarks icon and select “Audit Bookmarks” from drop-down menu to 

confirm no broken bookmarks are found 

Create Nested Bookmarks 

Note: Before Nesting Bookmarks, verify all Bookmarks contain correct page label names 

matching the names in the Thumbnails (which match drawing sheet numbers & labels) 
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Go to ‘Bookmarks’ Tab 

Select the first sheet in each section 

Right-click > Click “Add” > Select “Add Before…” 

Name new bookmark by section - Example: ELECTRICAL 

Select all “E” sheets and nest by pulling the documents over to the right under the 

ELECTRICAL bookmark 
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Repeat for all disciplines and other applicable documents (i.e. specifications which 

contain bookmarked sections) 

Set Scale on Floor Plans (as Applicable) 

Note: In addition to PDF plotting at Full 1:1 Scale, all Floor Plan Sheets should contain an 

appropriate measurement Scale that is stored in the PDF page. This is set within Bluebeam in 

the “Measurements” tab. 

Locate the Floor Plans 

Verify a scale is listed in the title of the Floor Plan. Design Teams must include a scale 

identification on all Floor Plans 

Within the “Measurements” panel  locate the Page Scale section 

Set Precision to 1/2 
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Manually enter the Scale to match the Scale of the Floor Plan, or select the scale from 

the “Preset” Scales (Bluebeam 2019/2020) 

Once the scale has been applied on a page, that scale is stored in the page. In 

Bluebeam 2018, the “Store Scale in Page” option is checked. In Bluebeam 2019, the 

page scale is listed within the Thumbnail. Check “Page Scale” in the Bluebeam 2019 

Label Options. 

Repeat for all Floor Plans 

Note: Once a Scale is set on one page, it will become the default to set other pages in 

Bluebeam 2018 - by checking “Store Scale in Page”. In Bluebeam 2019 & 2020, use the 

“Apply to Page Range” button to set multiple pages. 

Remove All Layers 

Go to Layers Tab 

Select layers listed 

Bluebeam 2019/2020 Bluebeam 2018 
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Note: To select all quickly, select the top layer of the list, hold the shift key and select 

the bottom layer simultaneously. 

Right-click on highlighted layers and select Delete from the drop-down menu 

Uncheck all options 

Click Delete 

Create Hyperlinks 

Note: Creating Hyperlinks as defined in this Section requires the Bluebeam eXtreme software 

version. 
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From the Batch pull-down menu, select Link > New 

Select “Add Open Files” uncheck any files that are not drawing files 
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Click Next 

Select Settings 

Select Filter Mode: “First from start” 

Select Filter Character. “’Space” 

Click OK 

Click Link Options 

Check Include Appearance Properties 

 Select a light-yellow color 

 Set Style to Highlight 

 Click OK 
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 Select Page Label 

 Click “Generate” 

 Search Terms will generate  

 Click run to create hyperlinks 

 Once the hyperlinks are created, click “Finish and Close” 
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Flatten the Document 

From the “Document” pull-down menu, select “Flatten” 

In the “Flatten Markups” dialog, check “All Markups” 

Verify ‘Allow Markup Recovery (Unflatten)’ is unchecked 

Click Flatten 

Save Documents 

Prepare Specifications and other Files for Initial Submittal 

Note: Additional document such as Specifications, Calculations, and other supporting files must be 

prepared in addition to the drawings to allow for proper review by UCSD.  

Files requiring review and/or comments by UCSD within a Bluebeam Session must be PDF file type. 

Files that are for reference may be other typical file types (Word, Excel, etc.) 

Preparation for non-drawings PDFs typically does not require a paid version of Bluebeam. 

Prepare Specifications 

Specifications shall contain bookmarks identifying Specification Divisions 

Specifications shall be free of Layers 

Specifications shall be Flattened 

Include 3.3” wide x 2.5” high blank area on the Specifications cover page for the 

Schematic Review Stamp and/or the Fire Marshal approval stamps 
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Bottom of box is 1” down from the lower right physical corner of the cover page 

and the top of the box is 3.5” up from the same corner. 

Prepare additional Supporting Documents 

All additional supporting documents shall be free of Layers 

All additional supporting documents shall be Flattened 

On any additional documents requiring approval, include 3.3” wide x 2.5” high blank 

area on the Cover page for the Schematic Review Stamp and/or the Fire Marshal and 

approval stamps 

Bottom of box is 1” down from the lower right physical corner of the sheet and 

the top of the box is 3.5” up from the same corner. 

Insert the UCSD Cover Page, including the Back-Check Status Menu (as Applicable) 

No If it is determined in the kick off meeting that the Design Team will be the Bluebeam Studio 

Manager then UCSD will supply a UCSD Cover Page to the Design Team (via email) and require the 

Design Team to attach the UCSD Cover Page as the first page of their submittal documents. Perform 

this step on any submittal document where UCSD Reviewers may add comments in a Bluebeam 

Studio Session.  If UCSD is the Bluebeam Studio Manager, UCSD will insert the cover page and 

manage the Bluebeam Studio Project and Session. 

Inserting the UCSD Document Cover Page automatically adds the UCSD Custom Status Menu. The 

Status Menu applied to the document allows the Design Team to track the review & incorporation 

comments, and UCSD Reviewers to track OPEN and CLOSED comments.  

IF THE UCSD COVER PAGE (INCLUDING THE BACK-CHECK MENU) IS NOT PROPERLY 

ADDED, THE REVIEWER BACK CHECK CANNOT BE PERFORMED PROPERLY 

Open the UCSD Cover Page and Verify Cover Page Completeness 

Note: Be sure to open the PDF in Bluebeam, not in Adobe. The Cover Page is filled out in the 

project kickoff meeting with input from both the Design Team and UCSD. 

Open the UCSD Cover Page.pdf file received from UCSD 
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Update and/or Verify UCSD Cover Page Completeness. Add or verify the following 

information 

The Project Name 

The Project Number 

Project Workflow Steps assignments, including Roles & Responsibilities for 

specific workflow tasks 

UCSD Departments Reviewing the Project (add & remove Reviewers from the 

list as needed) 

Save and Close the file 

Note: If the Cover Page has not been completed, coordinate with the UCSD Project 

Manager to assure the information added to the Cover Page is correct. 

Insert Cover Page 

Note: The UCSD cover page will be sent to the Design Team via email. Update the cover page 

prior to inserting into the individual documents. The page must be inserted using Bluebeam. 

In Bluebeam, open the submittal files (all documents where comments are required) 

Once all files are open, insert the cover page as the first page in each document 



Electronic Plan Review Procedure: Design Team 7/22/2021 
Page 24 

From the “Document” pull-down menu, select “Insert > Pages from Document” 

Note: If the “Open Project File” dialog appears, click “Open from Disk”. If “Insert 

Pages” dialog opens, click the “Add” button 

Browse to the locate the file titled “UCSD EPR Cover Page” and open the file 

In the “Insert Pages” dialog, select “Before” and check “First Page” to insert the 

cover page at the beginning of the document 

Click OK 

Verify the Cover Page has been added as the page 1 of the document 

Repeat for all submitted files that require Session review or addition of the back-check 

menu 
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Create the Bluebeam Studio Project (as Applicable) 

Note: In some instances, UCSD will require the Design Team to create the Bluebeam Studio Project 

for the Submittal upload. Creating a Bluebeam Studio Project requires a paid version of Bluebeam. 

A new Bluebeam Studio Project will be created for submission files to be added. Subsequent 

submission files will be uploaded into the same Studio Project and related Studio Session. Do not 

create new Studio Projects and Sessions for each revision submission. 

Log into Bluebeam Studio & Create the Studio Project 

Sign into Bluebeam Studio. Refer to the Section titled “Account Setup for Bluebeam 

Studio”. 

Click the Studio tab 

Click the Project icon > Click the Plus “+” icon > Select New Project  

Name the Project: 

Studio Project Naming Structure: [Project #]_[UCSD] [Project Name] 

Naming Example – Major Cap:  4466_UCSD Altman Research Institute 

Naming Example – Minor Cap:  55555_UCSD Altman Bldg AC System Update 

Note: Refer to Exhibit C: Bluebeam Studio Project Folders for Naming 

Instructions for both Bluebeam Studio Projects and Bluebeam Studio Sessions 

Click “OK”. A new Bluebeam Studio Project will be created 

Create Bluebeam Studio Project Folder Structure 

Note: the Bluebeam Project folder structure will be sent to the Design Team via email. Save the 

folder to a local drive prior to uploading.  

Once the Bluebeam Studio Project is created, click “Upload Folder” 
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Browse to locate the “UCSD EPR” folder provided by UCSD. Click & Select 

Note: Be sure to select the “UCSD EPR” folder, not a subfolder 

Folder and sub-folders will upload 

Set Up Bluebeam Studio Project Settings & Permissions 

In Bluebeam Studio Project, click Project Settings 

In the “General” tab, note the nine-digit Project ID number. 

Note: The nine-digit Bluebeam Studio Project ID number is the “key” needed to join 

Bluebeam Studio Projects 

Select the “User Access” tab 

Uncheck the “Restrict Users” checkbox 

Click “Apply” 
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Select the “Permissions” tab 

Set the Applied Permissions for to “Allow” for the following Permissions: “Send 

Invitations”, “Manage User Access”, “Send PDFs to Sessions”, “Revoke Check Out”, 

and “Share File Links”. 

Click the Groups button and create a group, titled “UCSD Administrator”, containing the 

following emails:  

AdminBBMajor@ucsd.edu (for Major Cap projects) 

AdminBBMinor@ucsd.edu (for Minor Cap projects) 

Add the “UCSD Administrator” group and assign the “Full Control” Permission 

Click “Apply” 

Click the “Folder Permissions” tab 

Change applied permissions on the “Project Root” folder to “Read / Write / Delete” 

Click “Apply” 
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Upload Documents to the Bluebeam Studio Project 

Submit files directly into a Bluebeam Studio Project 

Note: The Design Team will upload directly to the Bluebeam Project. If the UCSD Studio 

Administrator was the creator of the Bluebeam Studio Project, the Design Team will receive an 

invitation and a link to submit to the Bluebeam Studio Project via email. This invitation will be 

separate from the invitation to join the Bluebeam Studio Session. 

Uploading files directly to a Bluebeam Studio Project requires a paid version of Bluebeam. 

Access to a Bluebeam Studio Project requires a Bluebeam Studio Account. Refer to the 

“Account Setup for Bluebeam Studio” section located at the beginning of this Procedure for 

instructions on setting up a Bluebeam Studio account and required display name conventions 

for Bluebeam Studio accounts. The Account and display name must be set prior to submitting. 

Ensure all documents are named and formatted as defined within this procedure. 

Improperly formatted documents will be rejected by UCSD 

Open Bluebeam Software 

Verify connection to Bluebeam Studio  (i.e. the icon is “plugged in”) 

Open the Bluebeam Studio Project by clicking the link included in the email invitation 

(provided by UCSD). As long as the Design Team is connected to Bluebeam Studio , 

the link will open the Bluebeam Studio Project tab automatically.  

If a link is not available or not working, the Design Team may also open the Studio 

Project manually if they have been invited and have the Bluebeam Studio Project ID 

Note: The Bluebeam Studio Project ID is a random nine-digit code provided by UCSD. It 

is unrelated to the Application number or project address, etc. 

Click the Bluebeam Studio Projects button 

Under Bluebeam Studio drop-down menu select +. The “Join” dialog box 

appears. 

Enter the nine-digit Bluebeam Studio Project ID 

Click OK. The Bluebeam Project tab will open 
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Once the Bluebeam Studio Project tab is open, locate the correct folder / phase for the 

package upload in the “B. Design Team Submissions” folder.  

Note: Verify all file names are correct prior to upload. Refer to Exhibit D: Document 

Naming Table for Submissions for correct naming convention for all files.  

Right click on folder 

Select Upload Files Icon 

Browser window will open 

Select the file to upload (Hold Ctrl or Shift to select Multiple files) 

Select Open to upload the files 

Note: Bluebeam Studio Projects have a 180-character limit, including file 

names and folder names combined. If files fail to upload, verify the names of 

files and/or folders are not exceedingly long. 

Notify UCSD of Bluebeam Studio Project Submission 

Note: Once all submittal files have been successfully uploaded to Bluebeam Studio Project, 

notify UCSD Bluebeam Studio Administrator of Bluebeam Project submittal via email. 

Send to Bluebeam Studio Project invitation to the UCSD Studio Administrator and/or 

UCSD Project Managers 

In the Bluebeam Studio Project, click the (envelope) “invite” button 
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Click the “Copy invitation” button 

Note: This copies the Bluebeam Studio Project invitation-link to the computer’s 

clipboard.  

Open Outlook (or default email program) and open a new email message 

Address email to the UCSD Studio Administrator and/or UCSD Project 

Managers’ Email address 

Click “Ctrl-V” to paste the Bluebeam Studio Project invitation 

Send the invitation email to UCSD 

Description of Intake: Design Team Submittal Files 

Note: Once UCSD receives notification of the Design Team submission into the Bluebeam Studio 

Project, the UCSD Bluebeam Studio Administrator may perform a QAQC review of the submitted files. 

Please ask/confirm with UCSD if this will happen prior to adding submission files to the Session (if 

applicable). 

If document preparation is incomplete and/or not in compliance with this procedure, the Bluebeam 

Studio Administrator will notify the Design Team and request an updated resubmittal to the Bluebeam 

Studio Project. 

Create the Bluebeam Studio Session & Invite UCSD (as Applicable) 

Note: In some instances, UCSD will require the Design Team to create the Bluebeam Studio Session 

for the Submittal review. Bluebeam Studio Sessions are typically created directly from the Bluebeam 

Studio Project’s files for Electronic Plan Review. This is a best practice and should be followed 

whenever possible. 
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Create the Bluebeam Studio Session 

Log into Bluebeam Studio and open the Bluebeam Studio Project by joining the 

Bluebeam Studio Project ID number 

In the Bluebeam Project, locate the Document(s) to be uploaded to the Bluebeam 

Session for UCSD review 

Right-click on all PDF(s) to be reviewed by UCSD (Ctrl or Shift to select multiple) 

Select “Add to New Session…” 

Name the Session: 

Studio Project Naming Structure:  Project # _UCSD Project Name - REVIEW 

Major Cap Example:  4444_UCSD Kanzler Lecture Hall - REVIEW  

Minor Cap Example:  55555_UCSD Altman Bldg AC Update – REVIEW 

Click OK

In Bluebeam Session tab, click on the Session name select “Settings” from the drop-

down menu 

Click “Permissions” Tab 
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Set the Applied Permissions Attendees to “Allow” for the “Save As”, “Print”, “Markup”, 

“Markup Alert” and “Add Documents” Permissions 

Click Apply 

Click the “Attendees” tab 

Uncheck the “Restrict Attendees” checkbox 

Note: Sessions will typically be set to be “Open” (anyone with the Session ID can join). 

A Session that is “Restricted” means that only users invited or added in a Session 

Group can join. 

Notify UCSD of the New Bluebeam Studio Session 

NOTE: Once the Bluebeam Studio Session has been created, notify UCSD. The UCSD 

Administrator will then invite the Reviewers to the Session for the initial Review. Once the initial 

review is complete, the Design Team will join the Bluebeam Session to view and respond to the 

Reviewer’s markup comments. 

Send a Bluebeam Studio Session Invitation to UCSD 

Open the Bluebeam Studio Session tab 

Click on the envelope icon located to the right of the Attendees list 
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In the Session Invitation dialog, click the “Copy Invitation” button 

Paste into an individual email and send to the UCSD Studio Administrator and/or UCSD 

Project Manager(s). The pasted information will include the Session name, the Session 

ID number, and a Session link 
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Section D – UCSD Plan Review Process 

 Description of the UCSD Initial Electronic Plan Review Process 

Note: Once the initial review documents have been uploaded by the Design Team and have received 

approval from the Bluebeam Studio Administrator, UCSD Reviewers will begin the plan review 

process. Review time starts when the documents are found to be satisfactory. Reviews may be 

performed sequentially or simultaneously.  

 Respond to UCSD Review Comments 

Note: Once the UCSD initial document review has been completed, Design Team will be invited via 

email into a Bluebeam Review Session to incorporate comments. Incorporating comments is a joint 

process between the UCSD review team and the Design Team. 

Design Teams will respond, using the custom Status Menu in the Markups List, prior to resubmitting 

any revised documents. Once changes have been addressed by the Design Team using the custom 

Status Menu, the Design Team will create and upload subsequent submittal documents. 

Incorporation and response to Reviewer comments does not require a paid version of Bluebeam, but 

access to a Bluebeam Studio Session does require proper setup of a Bluebeam Studio Account. 

Before joining the Session, refer to the “Account Setup for Bluebeam Studio” section located within this 

Procedure for instructions on setting up a Bluebeam Studio account and required naming conventions 

for Studio accounts. 

Join the Bluebeam Studio Session 

Join via an Email Link 

 Open Bluebeam Software 

 Ensure Bluebeam Studio is Connected (icon is “plugged in”) 

 Locate the Bluebeam Studio Session invitation email 

 Click the link within the invitation to connect to the Bluebeam Studio Session 

Join via a Session ID 

 Locate the Bluebeam Studio Session invitation email containing the nine-digit 

Bluebeam Session ID (ex. 111-222-333) 

 Open Bluebeam Software 
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 Connect to Bluebeam Studio and click the Session button 

 Ensure Bluebeam Studio is Connected (icon is “plugged in”)  

 Within the Studio tab, locate and click the ‘plus’ button +. The “Join” dialog box 

appears 

 Enter the nine-digit Bluebeam Session ID and click “OK” 

Navigate Documents & Locate UCSD Reviewers’ Comments  

Note: For Bluebeam Studio Session layout, refer to QR4: Bluebeam Studio Session Layout 

Right-click on Session document. Select Open 

Open the Markups List Panel 

Note: the Markups List panel is typically located on the bottom of the Bluebeam 

software. In the “Window” pull-down menu, select “Panels >  Markups” or press 

ALT+L to show the Markups list if it is hidden. 

Locate Reviewers’ markup comments in the Markups List 

Note: The Markups List automatically tracks information for each Reviewer markup 

placed on a PDF, including Date, Page Label, Author, Color, Comments and Status. By 

default, it is found in the bottom panel.  
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Filter UCSD Reviewers’ Comments 

Note: The Filter feature within the Markups List allows a user to temporarily remove markup 

comments – “filtering”, or removing those comments based upon specific parameters. One can 

filter to only show a specific Author of comments, a specific page of comments, etc. 

On the Markups list toolbar, click the Filter icon 

A filter icon then appears next to each column heading in the Markups list 

Click the filter icon  associated with the desired column and select the value to filter 

Repeat as desired to filter by other values. 

Note: While filters are active, the markups list shows only those markups that match the 

selected filters. All other markups are hidden.  

Incorporate and Reply to UCSD Reviewer Comments 

Note: Design Teams must respond to each and every comment inside the Bluebeam Studio 

Session to indicate a reconciliation action or inaction to the reviewer.  

To notify the reviewer that the markup comment will be integrated into a revised document 

submission, the Design Team will set the Status of the comment to “AGREE - INCORPORATED 

in next Submittal (Reply as Needed for Clarity)”. There are two ways to do this: Right-clicking on 

the comment or double-clicking in the status column of the comment.  
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The Design Team will also indicate to the reviewer any changes related to the comments in the 

revised drawing, such as location or page changes, by using the “Reply” function. 

Once the Design Team has updated/revised the drawings and other documents per the review 

comments (prior to the subsequent submittal), the Design Team will use the Markups List 

“Status” column to indicate to UCSD that the Reviewers’ comment has been incorporated 

Incorporate Comments by Right-Clicking 

 Locate the Reviewer’s comment (either on the page or in the Markups List) 

 Right-click on the comment and select the Set Status 

 From UCSD Back Check Status menu titled: 

*****Design Team reply to Reviewer's comment***** and select:  

“AGREE - INCORPORATED in next Submittal (Reply as Needed for Clarity)” 

 Repeat until all comments have been incorporated completely 

Incorporate Comments using the Status Column 

 Double-click on the comment inside of the status column and select:  

“AGREE - INCORPORATED in next Submittal (Reply as Needed for Clarity) ” 

from the menu titled:  *****Design Team reply to Reviewer's comment**** 

Add an additional “Reply” to comments as Needed for Clarity 

 To add a comment/note related to a markup response, Right-click on the 

comment (either on the page or in the Markups List) and select “Reply” from 

drop-down menu. Type a response in the open text box stating how the 

comment has been addressed. Clearly indicate the location of the changes, 
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especially if they will deviate from the original page / location on the 

drawings. 

Non-Incorporated Status and Reply to UCSD Reviewers’ Comments 

Note: Design Teams must respond (using the “Reply” function) to each non-incorporated 

comment to indicate a reconciliation action or inaction to the reviewer.  

To notify the reviewer that the markup comment will NOT be integrated into a revised document 

submission, the Design Team will first set the Status of the comment to “DISCUSS or NEED 

UCSD INPUT (per reply)”. There are two ways to do this: Right-clicking on the comment or 

double-clicking in the status column of the comment. The Design Team must also add a 

response using the “Reply” function for each unincorporated comment, to explain the reason for 

non-compliance / not integrating the reviewer’s comment into the revised submission. After 

discussion, the Design Team can set a second status for the comment to denote the 

incorporated status.  

Locate the Reviewer’s comment 

Double-click on the comment inside of the status column, and select: 

“RECONCILED & NOT INCORPORATED (per reply)”  

from UCSD Back Check Status menu titled: 

 *****Design Team Reconciliation of DISCUSSED comments***** 

Another method is to Right-click on the comment and click:  

“Set Status > RECONCILED & NOT INCORPORATED (per reply)” 

from UCSD Back Check Status menu titled: 

 *****Design Team Reconciliation of DISCUSSED comments***** 

Add an additional “Reply” to reviewer comments as Required 

Add the required “Reply” comment to the response by right-clicking on the comment and 

selecting “Reply” from the drop-down menu.  



Electronic Plan Review Procedure: Design Team 7/22/2021 
Page 39 

Type a response in the text box stating the reason that the comment was not 

addressed. Clearly indicate the reasoning and explanation for non-compliance. 

 Subsequent Submittals 

Note: Subsequent submittals shall be submitted as entire sets of drawing plans – responding to 

corrections requested in the prior review. Resubmit the entire drawing set even if markup 

comments/changes only appear on a few of the individual pages. 

Add the UCSD Back Check Menu using the UCSD Bluebeam Profile 

Note: The first submittal requires the UCSD Cover Sheet. Addition of the Cover Sheet 

automatically adds the UCSD back check menu.  

Subsequent submittals do not require the UCSD Cover Sheet, but they do require the back 

check menu to be added. To add the back check menu to a document, the Design Team must 

load the UCSD profile, open the document, add the status menu, and then save the document. 

Perform this step on all documents where UCSD Reviewers will add comments.  

The Back Check Status Menu allows the Reviewers to track OPEN and CLOSED comments. 

IF THE BACK CHECK MENU IS NOT PROPERLY LOADED IN THIS STEP, THE BACK 

CHECK WILL NOT BE PERFORMED PROPERLY. 

Save Existing Profile Customizations (as applicable) 

Note: For experienced users that have predefined custom tools and/or profiles, verify that 

customizations have been saved in the current profile. Tool customizations must be saved 

before loading another profile, or they may be lost. 

Click the “Revu” drop-down menu 

Hover over “Profiles”. Note the Profile that is checked, and click “Save Profile” in the 

submenu 

Locate and Load the UCSD Profile 

Note: UCSD will supply the Bluebeam profile to the Design Team 

Locate the Bluebeam Profile, titled “UCSD Major Cap.bpx” (Capital Program 
Management jobs) or “UCSD Minor Cap.bpx” (Facilities Management jobs)
Verify that Bluebeam software is open 

Double-click the downloaded “UCSD Major Cap.bpx” or “UCSD Minor Cap.bpx” file.  

If the Profile loads correctly, Bluebeam will display the message “Successfully Imported 

Profile”  
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Load the UCSD Back Check Menu using the “Manage Status” Setting 

Note: If multiple Bluebeam profiles are used, verify that the UCSD Profile is the current active 

(checked) profile in the Revu pull-down menu > Profiles 

Open all revised submittal files requiring UCSD review 

Once all files are open, locate the Status Column in the Markups List  (typically 

located on the bottom of the Bluebeam software). 

Locate the Column titled “Status” within the Markups List  

Click the Settings icon  within the Status Column 

Select “Manage Status” from drop-down 

In the “Models” window, Verify the two state models titled 

“Design Team (Document Originator)” and  

“UCSD Reviewer Back Check” appear and are checked 

If Models appear correctly, click “OK”  

If the model states listed above do not appear or are listed differently: 

 Select incorrect model state in “Models” window 
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 Select Red “X” to delete 

 Click "OK” 

 Click the Settings icon  again in the Status Column 

 Select “Manage Status” from drop-down again 

 Verify model states appear correctly, as defined above 

 Click “OK” 

Once the Status Menu has been applied correctly, save the file 

Note: All files that will be reviewed electronically MUST BE SAVED to apply Status 

menus to PDFs for review.  

Repeat for all submitted files that require Session UCSD review or addition of the back 

check menu 

Submit Subsequent Revised Files Directly to the Bluebeam Studio Project 

Note: As Built and Record documents shall also be submitted into UCSD’s E-Builder system, as 

directed by UCSD. 

Ensure all documents are named per Exhibit D: Document Naming Table for 

Submissions. 

Ensure all documents are correctly formatted as defined within this procedure. 

Improperly formatted documents will be rejected by UCSD. 

Open Bluebeam Software and ensure Bluebeam Studio is connected 

Join the Bluebeam Studio Project  

Upload the documents into the corresponding phase in the “B. Design Team 

Submissions” folder. 

Note: Refer to the previous “Submitting files directly into a Bluebeam Studio Project” 

Section of these Procedures for instructions on both joining the Bluebeam Studio 

Project and Uploading documents. 

Once the files are submitted, notify UCSD Bluebeam Studio Administrator of 

Subsequent Submittal via email 

Submit Subsequent Revised Files into E-Builder 

Note: Construction submittal documents (As Built and Record documents) shall typically be 

submitted to into both Bluebeam Studio Project and into UCSD’s E-Builder system as directed 

by the UCSD Project Manager.  
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Description of Intake: Design Team Subsequent Submittal files 

Note: Once UCSD receives notification of the Design Team submission into the Bluebeam 

Studio Project, the UCSD Bluebeam Studio Administrator may perform a QAQC review of the 

submitted files. Please ask/confirm with UCSD if this will happen prior to adding submission files 

to the Session (as applicable). 

When the Bluebeam Studio Administrator has completed the intake and QAQC review and 

found the submitted files to be satisfactory, they will send out a notification to the UCSD 

reviewers to resume the Subsequent Electronic Plan Review in the Bluebeam Studio Session. 

Add Subsequent Submittals into a Bluebeam Studio Session (as Applicable) 

Note: In some instances, UCSD will require the Design Team to add the subsequent submittal 

files from the Bluebeam Studio Project into the Bluebeam Studio Session. UCSD may also ask 

the Design Team to set up new Studio Sessions for new Packages, Addendums, or milestone 

phases on large projects. 

Locate the new revised files to be added to the existing Bluebeam Studio Session  

Verify the UCSD Cover Page has been added. The Cover Page must be added as the 

first page of all submittal files requiring UCSD markup comments. 

Right-click the PDF files and select “Add to Existing Session” and select the existing 

UCSD Session. 

Note: If the “Add to Existing Session” option is not available, it is possible the Bluebeam 

Studio Session was created independently from the Bluebeam Studio Project. In that 

case the files must be temporarily saved from Bluebeam Studio Project to a local drive 

(right-click and “Download Copy”) and then added to the open Studio Session using the 

“Add Files” button. 

If creating a New Bluebeam Studio Session, Right-click the PDF files and select “Add to 

New Session” 

 Name the Session, and set Permissions for the Session, following the 

instructions in the section titled “Create the Bluebeam Studio Session & Invite 

UCSD (as Applicable)” within this document. 

Notify UCSD of Revised Submittal (as Applicable) 

NOTE: Once the subsequent submittal files have been uploaded into the Bluebeam 

Studio Session by the Design Team, notify UCSD via email.  
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Description of Subsequent Electronic Plan Review Process 

Note: Once the subsequent submittal files are in the Session, UCSD Reviewers will resume the 

plan review. 

After the Subsequent review phase has been completed, the Design Team will be notified to 

rejoin the Electronic Plan Review session to incorporate subsequent comments. The 

subsequent electronic plan review session will almost always be the same session as the initial 

review session. Refer to the “Joining the Bluebeam Studio Session” Section of these 

Procedures. 

Design Teams will respond to reviewer’s comments using the custom Status menus in the 

Bluebeam Markups List prior to resubmitting revised documents. Once changes have been 

addressed by the Design Team, the Design Team will create and upload additional subsequent 

submittals as required, until all submittal documents comply with UCSD requirements. 
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Section E – Approval & Closeout of Documents 

 Stamp-Out and Approval 

Note: Once all Reviewers and Departments, including the Fire Marshall and Director of Construction 

Inspections have reviewed and approved the documents, the Design Team will be notified that the 

electronic plan review is complete and the project is approved. Once that process is completed, the 

Design Team will be notified of “Final Approval” of the project by the UCSD Bluebeam Studio 

Administrator.  

The Design Team will receive notification to download the approved files from the Bluebeam Studio 

Project. Typically the approved files will reside in the Bluebeam Studio Project folder titled “C.UCSD 

Approved Documents. 
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Design Teams who choose to use Bluebeam for the Electronic Plan Review process should 

understand that some components of that process use a paid (licensed) version of Bluebeam, and 

some components use a free (unlicensed) version of Bluebeam.  

Breaking down the EPR workflow described in these Procedures into the four main components: 

formatting PDFs, creating Bluebeam Studio Projects & Sessions, submitting/resubmitting files, and 

responding to Reviewers’ comments, it is important to note which components use free or paid 

Bluebeam Revu software: 

• Formatting PDF Documents for submittal / resubmittal requires:

Bluebeam Revu Standard (for most formatting) and Bluebeam Revu eXtreme (for OCR and

Hyperlink creation)

• Creating Bluebeam Studio Projects & Sessions requires:

Any licensed (paid) version of Bluebeam Revu

• Submitting / resubmitting documents via a Bluebeam Studio Project requires:

Any licensed (paid) version of Bluebeam Revu

• Joining the Bluebeam Session and responding to Reviewers’ comments requires:

Any licensed (paid) or unlicensed (free) version of Bluebeam Revu

Design Teams or Design Team Subcontractors wishing to review and respond to in-Session UCSD 

Review comments can do so using a free (unlicensed) version of Bluebeam. The free (unlicensed) 

version of Bluebeam is simply an installed trial version where the trail has expired. Note that this 

functionality will only be available when working on Session documents while inside a Bluebeam 

Session. 




